THE USE OF TEMPORARY TOWERS TO OPTIMIZE THE COMPLETION OF RECONDUCTORING AND TOWER REPLACEMENT OF 150 KV HIGH VOLTAGE OVERHEAD LINES (SUTT)

Muhammad Iqbal
Sepuluh Nopember Institute of Technology, Surabaya, Indonesia
ak3u131.17@gmail.com

ABSTRACT

Transmission lines play an important role in the successful and stable operation and distribution of power grids both for power evacuation from power plants and as a link from one Substation to another. The construction of new transmission lines as a form of meeting high electricity needs in the current era of Globalization has many obstacles, both in terms of rejection from residents, expensive licensing arrangements, and very expensive investment costs. Reconductoring is one of the methods of increasing transmission capacity at minimum cost with an adequate level of quality and reliability. Reconductoring is the best solution today to increase conductor conducting capacity with the least investment and get maximum economic efficiency. However, considering that reconductoring is an addition of transmission capacity using old or existing lines and also requires tower replacement, so an outage with a long duration is needed which is feared to have an impact on system reliability. Therefore, the use of emergency towers is believed to be a solution to shorten the blackout time. Emergency towers are used as tools in reconductor work and tower replacement. A study was conducted by calculating the Cost Budget Plan (RAB) and schedule analysis using the Microsoft Project Application to determine the comparison of the duration of time needed to complete reconductoring work and tower replacement between using an emergency tower and without an emergency tower. From the time schedule made, it will be known which work method uses a shorter duration of time so that it can save or speed up the blackout time. This study is expected to produce a shorter schedule of reconductoring and tower replacement work using temporary/emergency towers and with a smaller RAB compared to Total Operating Costs so as to shorten the duration of the outage time at an efficient cost.

Keywords: Rekonduktoring, Tower Emergency, Speed up work

INTRODUCTION

PT PLN (Persero) is a company engaged in electricity, one of its activities is to build electricity infrastructure, manage network construction activities, supervise construction and carry out construction administration processes by acting as the owner of work (owner) and Director of Work for PT PLN (Persero) Head Office contracts by producing quality networks and ready to operate with processes implementation of development based on cost, quality and on time (Aldi et al., 2022; Maidin et al., 2022).

150 kV Reconductoring Work is one of the electricity network projects built by PLN which is one of the Government Programs in building national electricity. The Sukatani New-Sukatani 150 kV SUTT Reconductoring Work is needed to be able to evacuate energy production from the plant to the load, especially with the plan to build a Java 1 2x800 MW PLTGU with a radial connection from GITET Cibatu Baru II / Sukatani and increase the reliability of industrial center supply, especially to supply industrial estates on the north side of Karawang. The existing conductor of SUTT 150 kV Sukatani New-Sukatani currently still uses Dove 1x298 mm2 with a capacity of 600 A. This will certainly be a very crucial factor because this section will be used as a power evacuation outlet from GITET Sukatani through GIS 150 kV Sukatani New towards Sukatani-TX-Bekasi-Kosambi Baru so it must be reconductored because it requires a larger conducting capacity (Kishore & Singal, 2014).

In order to support the plan of the 150 kV Sukatani Ne-Kosambi Baru SUTT Reconductoring work, it is necessary to carry out the 150 kV Sukatani New-Sukatani SUTT Reconductoring work first so that bottleneck does not occur on this path when evacuating power from PLTGU Jawa 1 2x800 MW.
The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)

Construction work on the SUTT 150 kV Kosambi Baru-Sukatani reconductor as a reinforcement of the GITET 500 kV Sukatani power evacuation outlet which will operate in 2022 (PT PLN (Persero) Unit Induk Pusat Pengatur Beban, 2019).

The configuration of GITET 500 kV Sukatani is to cut 2 circuits of SUTET 500 kV Muara Tawar – Cibatu. GITET 500 kV Sukatani New outlet is GIS 150 kV Sukatani New whose configuration plan cuts 2 circuits SUTT 150 kV Bekasi-Kosambi Baru (PT PLN (Persero) Unit Induk Pusat Pengatur Beban, 2019).

The Reconstructor Work of the 150 kV Sukatani New-Sukatani SUTT is targeted to be completed in December 2022 considering that the 150 kV Sukatani New GIS will be operated at the end of 2022 so that the evacuation of power from the Java 1 2x800 MW PLTGU through the 500 kV Sukatani GITET and the 150 kV Sukatani New GIS Step Down will be optimal.

This research will discuss the use of emergency tower tools to accelerate the completion of the Sukatani New-Sukatani New-Sukatani 150 kV SUTT Reconductoring work compared to not using emergency towers in order to pursue operating targets at the end of 2022 in accordance with the Key Performance Indicator (KPI) targets set by management. Given that the tower on the line is very old and has a conductor with a small capacity that is no longer suitable with the current technological capacity, so the project is highly recommended by users to immediately reconductor and replace the tower. In addition, this line is a crucial line that is currently very reliable to supply electricity from Sukatani New to Sukatani and Kosambi Baru where when this work is carried out, blackouts with too long a duration of time are not allowed (Mbuli et al., 2019; Reed et al., 2020).

This reconductoring project is very closely related to blackouts so that in order to anticipate and minimize the duration of long work time, an emergency tower method is needed so that it can reduce the duration of time. So it is expected that the outage of the line will not be too long which is feared to disrupt the need for electricity supply on the line.

RESEARCH METHOD

Data collection in this study was carried out by collecting information from a 150 kV transmission reconductoring project at PT PLN (Persero) which is very useful for evaluating overall time and cost optimization (Vadivel, 2017). This study requires several designs as direction (guidance) in data collection so that the data obtained there is no doubt about its validity and reality, as follows: Design Criteria for determining the type of conductor, Parameter Design, namely by applying Operations Management such as human resources, cost budgets, conductor materials, machines, methods; Experiment Design (Teniwut, 2022).

Data sources in this study use primary data, with field surveys, holding Group Discussions (FGDs) to determine Decision Criteria, Cross Checking, Validity and Reliability. Secondary data is data obtained from the results of collecting various previously existing data that will be used by researchers to complement primary data that has been obtained, including contract document books, Cost Budget Plans (RAB), data from other agencies such as contractors, construction supervision consultants and other data related to the research topic. The variables that greatly influence the optimization of project implementation time and cost are time variables and cost variables (Kopsidas & Rowland, 2009).

Data processing, steps as follows: Create and Calculate Budget Plan (RAB) Contract Amendment; Create a project comparison time schedule; Calculating the Cost Comparison Value between the Amendment Budget and Total Operating Costs.

Data Analysis, After data processing is carried out both starting from making and calculating the cost budget plan (RAB) for contract amendments, Primary Data, and Secondary Data, the output is obtained in the form of comparative data, including: Cost Budget Plan Value (RAB), and Time Schedule for the implementation of work, then these data are analyzed as a reference in choosing which method is more effective and efficient in completing projects in Research this time.
The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)

Drawing conclusions and suggestions, The last step includes the analysis obtained from the results of data processing carried out during the research and the results of analysis and discussion can be concluded as the results of the research as a whole.

RESULT AND DISCUSSION
Field Data
The project reviewed in this study is one of the Network Transmission Reconductoring projects at PT PLN (Persero) SUTT 150 kV Sukatani New towards Sukatani 4-CIRCUIT OHL 2 X TACSR 410/67 mm2 (Krishnasamy et al., 1981; Riba et al., 2020; Schweiner et al., 2003).

The Cost Budget Plan and time schedule for the project can be seen in the following explanation.

Data Analysis
This analysis will explain how the Microsoft Project program can be used to speed up outage times with variations using Temporary/emergency Tower, with the following stages:
1. Drawing up a project schedule and cost plan (Wale et al., 2015),
2. Acceleration of project blackout time with variations using Tower Emergency. Then the result of accelerating the blackout time with variations using Tower Emergency is in the form of changes in costs before and after using Tower Emergency compared to the duration of the outage.

Creating Project Schedules and Costs
The steps in creating a project schedule by using the Microsoft Project program can be done as follows (Harefa, 2021):
1. Open a new worksheet Click the Start button > Microsoft Office > Programs > Microsoft Project.
2. Enter the project's effective date. Enable the Project > Project Information menu. In the Project Information dialog box, Schedule From: Project Start Date is selected, then enter the project's effective date, which is August 1, 2022 in the Start Date box. These steps can be seen in Figure 1 below.

![Figure 1](image)

Enter the Project's Effective Date date

3. Create a work schedule to determine working days and hours. This project uses a typical calendar workday of 7 working days per week with 8 hours of work per day. Enter the data
on the number of working days and hours in the Microsoft Project program, first click the Tools menu > Change Working Time > Work Weeks > Details then in the select day(s) box select all days then select Set day(s) to these specific working times. Next, enter the working hours in the Form boxes: 08.00 To: 12.00 and Form: 13.00 To: 17.00 > OK. Then on the Work Weeks view select Options, fill in the data in the Default start time box: 08.00; Default end time: 17.00; Hours per day: 8.00; Hours per week: 56.00; and Days per month: 30. Langkah-langkah tersebut dapat dilihat pada Gambar 2, Gambar 3, dan Gambar 4 berikut ini:

4. After all project preparation and determination of the calendar of working days and hours, the next step is to compile data on project activities consisting of all work items that form the sequence of the entire series of activities. Work items in project activities are performed
5. In the following steps: From the View menu > click Gantt Chart > in the Task Name field, enter the name of the entire series of work activities, in the Duration field, enter the time duration of each job. Then create relationships between work items entered in the Predecessors column, after the Task Name, Duration, Predecessors columns have all been filled then the Start and Finish columns will be automatically filled with the right display showing the results in the form of a Gantt Chart according to the data entered. The results can be seen in Figure 4 below.

![Figure 4](image_url)

**Figure 4**
**Work Item Creation with Gantt Chart view**

**Acceleration of Blackout Time with Variations Using Tower Emergency**

The acceleration of project blackout time with variations using Tower Emergency is carried out by filling in Tower Emergency data which is then compared with normal conditions, namely conditions before acceleration. The steps at this stage include:

1. In the *Gantt Chart* view, add Tower Emergency work items and data
2. Enter the duration of a work item as planned

![Figure 5](image_url)

**Figure 5**
**Enter the Effective Date of the Project by using the Temporary Tower**
The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)

3. Entering project activity data using Tower Emergency

![Figure 6: Creation of Work Items with Temporary Tower with Gantt Chart display](image)

**Discussion**

**Project Acceleration to Reduce Outage Time Duration**

Following up on a request from the Load Control Unit that in order to maintain the reliability of electricity supply in the Java system, it is necessary to accelerate work related to the blackout of existing lines. In this research, of course, it can be done using the Temporary Tower tool (Ahmed & Saqib, 2020; Ines & Ammar, 2020).

Shortening the duration of outage time is the main point in the implementation of this reconductor project. With a relatively shorter duration of blackouts, it can maintain the reliability of the electricity system on the island of Java. The following is a comparison of the calculation of the duration of the outage time between without using a temporary tower and using a temporary tower.

**Acceleration Measures**

The acceleration steps in the reconductor project plan are described as follows (Rashmi et al., 2017; Reddy & Chatterjee, 2016).

1. Without Using Temporary Tower

   Conditions if the reconductor work is carried out without using a temporary tower, then the blackout time of this reconductor project is 148 days. These activities cannot be accelerated, because the system must be completely extinguished during erection work T.04 and Upgrading work of existing Towers T.76, 77 and 78 in the direction of Sukatani.

2. Working Method Without Using Tower Emergency. Stages of Work Implementation:

   a) 148-day blackout permit for erection work T.04 up to upgrading work T.76, 77, and 78
   b) Mobilization of Manpower and Equipment to tower point T.04
   c) Work began with dismantling conductors, fittings & accessories, towers, up to the foundation of the existing tower footprint (T.76, 77, and 78)
   d) After the existing tower dismantling work until the foundation is completed, the foundation material curtain work and the new T.76, 77, and 78 foundation work continue
   e) Continued curtain and erect tower work T.76, 77, and 78 after a concrete curing period of ± 8 days
   f) After the erect tower work was completed, the work continued to pull Line 1 conductors from T.04 to T.75E
   g) After the Line 1 conductor has been installed, continue to draw the Line 2 conductor Line
   h) Finished the work of pulling Line 1 and 2 conductors, continued the implementation of Rele Line Diff installation work at GI Lawan, then carried out Individual test &;
The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)

Function work, SAS Integration and Testing &; Commissioning at GI Sukatani Gobel and GIS Sukatani New

i) After the Testing & Commissioning Work is completed, the Point to Point, Stability Line Diff and Intertrip exams continue

j) Continued issuance of RLB and Energize direction Sukatani Gobel.

3. Dengan menggunakan Tower Emergency

The acceleration step in question is to shorten the blackout time in the work produced by the previous stage, which is the normal stage. The calculation of acceleration needs using the Temporary Tower inputted under normal conditions led to a reduction in project blackout time from 148 days to 16 days. This acceleration caused the project cost requirement to experience an additional cost of Rp 1,872,217,454 from the original plan cost.

4. Working method using Temporary Tower

Stages of Work Implementation:

a) Mobilization of Manpower and Equipment to the point tower T.04

b) Blackout permit for 14 days from Erection work to Cut joint work

c) Complete erection work at T.04 and perform final check

d) Line up conductor from direction T.03 to T.04 3 phase up line direction Bekasi and continued 3 phase down direction sukatani gobel.

e) Thorough checking of the strength of tower members, tower body and cross arm as well as bolt fittings accessories

f) Ensuring the strength condition of the T.79E to avoid chronic damage

g) If the condition of T.79 is still strong, the cut join work can be started by unclamping on T.79 and installing the roll

h) The work of erecting the Temporary Tower along with the work of Mobilizing Manpower and Equipment to the tower point T.04

i) Established 3 temporary tower points with sekur reinforcement

j) Install insulators and accessories at the end of the crossarm temporary tower and roll mounted

k) Carrying out a new cable withdrawal 2xTACSR 410 in the Temporary Tower from T.75E to T.04

l) After erection T.04 is complete, new cables are clamped in T.04 and in T.75E

m) The conductor in T.04 will be cut, which is from the direction of Sukatani line, the temporary tower is placed in the lower 3 phase crossarms and the one from Bekasi direction is in the upper 3 phase crossarms

n) Carry out Rele Line Diff installation work at GI Lawan, then do Individual test &; Function and Testing &; Commissioning work

o) After the Testing & Commissioning Work is completed, the Point to Point, Stability Line Diff and Intertrip exams continue

p) Followed by the issuance of RLB and Energize Line 1 in the direction of Sukatan

q) After the work of cutting the connection of T.04 and Energize Line 1 in the direction of Sukatani Gobel, the work on uprating the existing towers T.76, 77, and 78 can begin

r) Pekerjaan dimulai dengan dismantling konduktor, fitting & accessories, tower, sampai dengan pondasi tapak tower eksisting

s) After the existing tower dismantling work until the foundation is completed, the new T.76, 77, and 78 foundation work continues

t) Continued curtain and erect tower work T.76, 77, and 78 after a concrete curing period of ± 8 days

u) After the erect tower work was completed, the conductor withdrawal work continued from T.04 to T.75

v) Furthermore, the permit went out for 2 days for the transfer of conductors from the temporary tower to towers T.04, T.76N, T.77N, T.78N and T.75E

w) After Line 1 and Line 2 conductors have been installed in T.04, T.76N, T.77N, T.78N and T.75E, Stability Line Diff and Intertrip tests are carried out
The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)

x) Continued issuance of RLB and Energize Line 2 and Line 1 in the direction of Sukatani Gobel.

**Changes in Outage Time Duration**

The duration of time under normal conditions or if reconductor work is carried out without using a temporary tower requires a blackout time of 148 days, while if using a temporary tower, a shorter blackout time is obtained, which requires a blackout time of 16 days. So from the results of the analysis that has been done in this study there was a decrease of about 132 days or about -89%.

![Outage Time Comparison Model Between Using Temporary Tower and Without Temporary Tower](image)

**Cost Comparison Before and After Using Tower Emergency**

A significant decrease in the duration of the blackout time of 89% if the reconductor work is carried out using temporary towers has an impact on increasing project costs. The results of the comparison between the cost of normal conditions without using a temporary tower with the cost to shorten the duration of the outage time if reconductoring is carried out using a temporary tower shows that there is an additional cost. But the required duration of the outage became faster by 132 days. This means that it is still better because the additional cost of Rp. 1,872,217,454 is still smaller than the loss received by PLN if this reconductoring work cannot be completed.

**CONCLUSION**

Based on the data, the results of the analysis and discussion conducted in research on one of the Network Transmission Reconductoring projects at PT PLN (Persero) SUTT 150 kV Sukatani New towards Sukatani, can be concluded as follows:

Comparison of the duration of the blackout time if the reconductor work is carried out without using a temporary tower, then the blackout time of this reconductor project is 148 days. These activities cannot be accelerated, because the system must be completely extinguished during erection work T.04 and Uprating work of Existing Towers T.76, 77 and 78 in the direction of Sukatani. Meanwhile, if you use a temporary tower, you get a much shorter blackout time, which requires a blackout time of 16 days. So that from the results of the analysis that has been done in this study there was a significant decrease of about 132 days or about -89%.

The duration of the contractual implementation time also has a faster impact if the reconductor work is carried out using a temporary tower where if the reconductor work starts on August 1, 2022, the work can be completed on December 26, so that the 2022 KPI target can be
The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)

achieved. Meanwhile, if the reconductor work is carried out without using a temporary tower, the new work can be completed on January 10, 2023, causing the KPI for 2022 not to be achieved. Shortening the duration of the outage time if reconductor work using temporary towers causes the project cost requirement to increase by Rp 1,872,217,454 from the original plan cost.

REFERENCES


The Use of Temporary Towers to Optimize The Completion of Reconductoring and Tower Replacement of 150 Kv High Voltage Overhead Lines (SUTT)


